How to get your article ready for publishing: ELRR style guide and template [Title]
How to use this template [Heading 1]
Welcome to the Economic and Labour Relations Review (ELRR) style guide. This document is also a template and contains built in styles. We highly recommend that you use them for consistency and ease of formatting. To use, simply copy and paste your manuscript into this style template, rename and save. To apply a style simply highlight the relevant text and select the appropriate style from the ‘Styles’ menu on the ‘Home’ tab. In this document you will find that styles have been applied to all text as an example of correct style and the relevant styles have been denoted at the end of the paragraph like this: [Body text first para].
When you have finished styling your manuscript simply delete these instructions and save. [Body text with indent]
General formatting [Heading 1]
Title and headings [Heading 2]
All titles and headings should be written in sentence case, not title case. [Body text first para]
Your manuscript title should identify the concepts, implications, significance or novelty of your article. Such titles often contain keywords and phrasing which are likely to gain more hits on social media platforms and online searches more generally. Avoid titles that are empirical or descriptive in nature. [Body text with indent]
Example: How to get your article ready for publishing: ELRR style guide and template.
Below is a sample of the heading styles used by ELRR. [Body text first para]

(Capitalisation style: sentence case) [Title]
First-level sub-headings are sentence case [Heading 1]
Second-level sub-headings are sentence case [Heading 2]
Third-level sub-headings are sentence case [Heading 3]
Fourth-level sub-headings are sentence case and used for tables, figures and examples [Heading 4]

Alignment and line spacing [Heading 2]
We left align (no paragraph indent) all first paragraphs after headings, tables, charts, figures, block quotes and bulleted or numbered lists. All subsequent paragraphs are first line indented (see following paragraph) [Body text first para]
All paragraphs are justified and will be single spaced at publication. We use 1.5 line spacing in this template for editing purposes. [Body text with indent]
Your final submitted manuscript should be clear of track changes and ready for print. [Body text with indent]
Language and spelling [Heading 2]
The ELRR uses UK English. You can change the default proofing language for your manuscript to make it easier to employ correct spelling. 
To change the proofing language in Microsoft Word go to the ‘Review’ tab and select ‘Language’, ‘Set Proofing Language’, and either ‘English (Australia)’ or ‘English (United Kingdom)’. Please retain original spelling for all quotes — do not convert them to UK English. [Body text first para]
We use -ise not -ize, and labour not labor. Please retain the original spelling of ‘labor’ and ‘organization’ for quotes and proper nouns e.g. International Labour Organization. [Body text with indent]
Lists [Heading 2]
There are two types of lists. Standard:
You can use the standard bulleted list [List bullet]
You can use the standard bulleted list [List bullet]
And numbered:
You can use numbered lists [List bullet numbered]
You can use numbered lists [List bullet numbered]
You can use numbered lists [List bullet numbered]
Acronyms [Heading 2]
Please spell out in full in the first instance followed by the acronym in parentheses as follows, Economic and Labour Relations Review (ELRR). For subsequent use you may use ELRR. [Body text first para]
Abbreviations [Heading 2]
We do not generally italicise abbreviations and use punctuation as follows:
etc.	e.g.	i.e.	ed. 	Eds. (BUT et al )   
Notes [Heading 2]
Explanatory notes should be kept to a minimum. If it is necessary to use them, they must be numbered consecutively in the text and listed at the end of the article i.e. we use endnotes,1 not footnotes,2 with the notation appearing in superscript after any punctuation as illustrated in this sentence.3 Please do not embed notes in the text. [Body text first para]
Quotations and referencing [Heading 1]
Quotation marks [Heading 2]
Use ‘single’ marks for normal use and “double” quotation marks for ‘“quotes” within quotes.’ Punctuation belongs inside of quotation marks when appearing at the end of a sentence or phrase. [Body text first para]
Block quotes [Heading 2]
Indent quotations of more than three lines, no inverted commas.
Example display of quotes over three lines. Example display of quotes over three lines. Example display of quotes over three lines. Example display of quotes over three lines. Example display of quotes over three lines. Example display of quotes over three lines. (Inline citation appears here) [Block quote: secondary evidence]
Indent and italicise quotations of primary evidence.
Example display of quote from an interview participant. Example display of quote from an interview participant. Example display of quote from an interview participant. Example display of quote from an interview participant. (Interview description details) [Block quote: primary evidence]
Inline citations [Heading 2]
Alphabetise multiple reference citations inline and present in text using the formats listed below. In general, we use no punctuation between author names and the publication year, use a comma to separate the publication year and page number/range and a semi-colon to separate the listing of multiple authors. [Body text first para]
Please do not embed bibliographic references in the text, footnotes, live links or macros.  [Body text with indent]
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CAMBRIDGE A CITATION (note et al has no full stop) 
Single author [Heading 3]
(Cook 2013)
Two authors [Heading 3]
(Bicchieri and Xiao forthcoming)
Three or more [Heading 3]
(Bhatti et al 2018)
Corporate author [Heading 3]
Long author names can be shortened but must include both the short and complete form in the reference list.
(International Monetary Fund 2015) or (IMF 2015)
Multiple references and authorship similarities [Heading 3]
(Campos 1972a, 1972b; Dundas et al. 2008b; Macdonald, Poulton, Glendining et al 2007; Macdonald, Poulton, Clark et al 2007; X Zhao 1982; Y Zhao 1982)
Citations with pages or other specific references (use full page numbers when giving page ranges) [Heading 3]
(Ronnow-Rasmussen 2011, 47)
(Kang 1998, fig 3)
(Dryzek 2002, 12n4)
(Hammersmith 1972, sec 2.5)
(Weinberg 1964, 216–233)
Reprint editions
(Cobo 1956 [1653], 169)
Reference List [Heading 2]
Overview [Heading 3]
Arrange references alphabetically by author surname, with all the authors listed. List author names in ‘last name first name’ format, with the first names given in initials. 
List two or more works by the same author or authors chronologically. 
To distinguish two or more works by the same author or authors in the same year, use a, b, c, etc. following the date, and list references in the order in which they are mentioned in the text. 
Do not use the three-em dash for repeated authors, as this throws off indexing engines. 
For titles of journal articles and book chapters, use sentence style capitalisation (minimum capitalisation). Do not enclose the titles in quotation marks. 
For book and journal titles, use headline style capitalisation (maximum capitalisation) and italics. Always list journal titles in full rather than in abbreviated form. 
Do not elide page numbers when giving page ranges (thus, it should be 213-229 not 213-29). 
For journal articles, doi information should be included where available. Both the URL format (http://dx.doi.org/10.1017....) and the abbreviated format (doi:10.1017…) are acceptable. 
Examples [Heading 3]
These are just a few examples, for further details please refer to 
Cambridge Reference Styles: ELRR CambridgeA 2025 
Books [Heading 4]
Kenny DA, Kashy DA and Cook WL (2006) Dyadic Data Analysis. New York: Guilford Press. 
Edited, compiled, or translated book, with author name given [Heading 4]
Agius E and Busuttil S (eds) (1998) Future Generations and International Law. London: Earthscan. 
Kadare I (2002) Spring Flowers, Spring Frost, Bellos D (trans). New York: Arcade. 
Cage J (2016) The Selected Letters of John Cage, Kuhn E (ed). Middletown, CT: Wesleyan University Press. 
Book chapter [Heading 4]
Chapman R (2011) Representing nature. In Alonso S, Keane J and Merkel W (eds), The Future of Representative Democracy. Cambridge: Cambridge University Press, 236–257. 
Journal article (it is not necessary to provide an issue number for journals that are paginated by volume): [Heading 4]
Chétima M (2019) You are where you build: Hierarchy, inequality, and equalitarianism in Mandara highland architecture. African Studies Review 62(3), 40-64. https://doi.org/10.1017/asr.2018.45. 
Belasco E and Schahczenski J Is organic farming risky? An evaluation of WFRP in organic and conventional production systems. Agricultural and Resource Economics Review, published online 16 July 2020, doi:10.1017/age.2020.13.  
Preprint [Heading 4]
Cai Y, Brock W, Xepapadeas A and Judd K (2019) Climate policy under spatial heat transport: cooperative and noncooperative regional outcomes. arXiv preprint 1909.04009. Available at https://arxiv.org/abs/1909.04009 (accessed 1 August, 2020). 
Article in conference proceedings (examples with and without an editor given) [Heading 4]
Bhatia SB and Kumar S (1979) Recent Ostracoda from off Karwar, west coast of India. In Krstic N (ed), Proceedings of the VII International Symposium on Ostracodes. Taxonomy, Biostratigraphy and Distribution of Ostracodes. Belgrade: Serbian Geological Society, 173–178. 
Paper presented at a conference [Heading 4]
Momcilovic D (2019) Armies of the undead: the slow and awkward march of the Balkan zombie. Paper presented at the ACLA Annual Meeting, 7-10 March, Georgetown University, Washington DC. 
Magazine article [Heading 4]
Thompson D (2020) How long does COVID-19 immunity last? The Atlantic, 20 July. Available at https://www.theatlantic.com/ideas/archive/2020/07/could-covid-19-immunity-reallydisappear-months/614377/ (accessed 20 July 2020). 
Newspaper article (if there is no author given, begin reference with the title) [Heading 4]
Eisen MB and Tibshirani R (2020) How to identify flawed research before it becomes dangerous. New York Times, 20 July 2020. 
Published or broadcast interview [Heading 4]
Aung San Suu Kyi (2017) Interview by F Keane, 5 April 2017. BBC News. Available at https://www.bbc.com/news/av/world-asia-39510271/myanmar-aung-san-suu-
Websites [Heading 4]
Disaster Medicine and Public Health Preparedness (2015) Instructions for authors. Available at https://www.cambridge.org/core/journals/disaster-medicine-and-public-healthpreparedness/information/instructions-contributors (accessed 20 July 2020). 
Note: In this example, the publication date is the date of last update. If a publication date or date of last update is not available, use nd.  
Social media posts [Heading 4]
Maths at Cambridge [@cambUP_Maths] (2020) It's been a great year for @JFluidMech, which is also number 1 on Google Scholar for #fluidmechanics, with an h-index of 63. 15 July 2020. Available at https://twitter.com/cambUP_maths/status/1283390254544715779. 
Note: Cite this in the text as (Maths at Cambridge 2020). The entire text of the tweet is included in the reference in this case. 
Speeches [Heading 4]
Genn H (2012b) Why the Privatisation of Civil Justice is a Rule of Law Issue. 36th FA Mann Lecture, Lincoln’s Inn, 19 November 2012. Available at https://www.ucl.ac.uk/laws/judicialinstitute/layoutcomponents/36th_F_A_Mann_Lecture_19.11.12_Professor_Hazel_Genn.pdf (accessed 6 November 2017)
Reports [Heading 4]
Food and Agriculture Organization of the United Nations (FAO) (2015) World Reference Base for Soil Resources 2014. International soil classification system for naming soils and creating legends for soil maps. World Soil Resources Reports No 106. Rome: FAO, IUSS Working Group WRB
All things mathematics [Heading 1]
Currency [Heading 2]
Use ISO Codes, not symbols e.g. EUR 150, AUD 20, USD 60.
Percentages [Heading 2]
Use %, not percent or per cent.
Metric and imperial measurement [Heading 2]
Metric is preferred. If imperial is used, provide metric equivalents.
Formulae [Heading 2]
Please use the insert equation function for any formulae you wish to include. This can be found on the ‘Insert’ tab under ‘Symbols’, ‘Equations’. For example:



Charts, figures and tables [Heading 2]
Charts, figures and tables should be prepared and submitted in separate files, unless using LaTeX. Acceptable file types include Microsoft Word (.doc/.docx) for images created in Microsoft Word and Microsoft Excel (.xls/.xlsx) for graphs or tables. Image files should not be embedded into Word documents. [Body text first para]
  Use placeholders to mark position in the main manuscript as show here. [Body text with indent]

[TABLE 1 HERE]

Do not embed chart and figure headings, source notes or other additional notes within the chart or image. These items should remain as separate elements of text to which editing styles can be applied. [Body text first para]
Include source information and any additional notes in the Figure/ Table file. Captions appear above tables and below figures, with one line space above and below the main text and the Table/ Figure. See example below. [Body text with indent]
Table 1. Use the fourth-level sub-heading for table and figure captions. [Heading 4]
	Column 1[table text]
	Column 2

	Item 1
	0.035

	Item 2
	0.452

	Item 3
	0.001


Include source data and any relevant notes.

Resumption of main text starts here and illustrates line spacing surrounding tables and figures. [Body text first para]
SEE CHECKLIST BELOW 

CHECK BOX 1
	[bookmark: _Hlk147753810] ARTICLE CHECK BOX for authors
	

	
	YES

	Is the title a good and clear indicator of the substance of the article?
	

	Do you provide a well written concise and thorough abstract (less than 250 words)? 
	 

	Are you clear about the core question / problem? Will your reader understand the main questions?
	

	Do you show that you have a good understanding and critical appreciation of the international literature? 
	 

	Is the literature review a well structured discussion? (NOT an annotated bibliography) 
	 

	 Have you spelled out the purpose and objectives of the article?  
	 

	Are you clear on your use of theory / methodology and methods?  Have you shown your reader why you chose your theory / methodology?   
	 

	Have you identified, explained and discussed your findings (for policy and / or scholarship)? 
	 

	Is your conclusion clear and thorough? Have you been clear on *how* your paper demonstrates a real contribution to the scholarly and / or policy literature?
	 

	ALSO …. 
	 

	Is your article well written and readable? 
	 

	Is this paper appropriate for ELRR? https://www.cambridge.org/core/journals/the-economic-and-labour-relations-review/information/about-this-journal 
	 

	 Is the article formatted correctly and wholly in house style? (NB UK spelling & Cambridge A https://www.cambridge.org/core/journals/the-economic-and-labour-relations-review/information/author-instructions/preparing-your-materials) (PLEASE SEE HOUSE STYLE CHECKLIST) 
	 

	Are Tables / figures appropriately titled and organised? And in separate files?
	

	Are all authors clearly identified?  Have you provided a brief bio of the authors? 
	 

	Have you fully and thoroughly proofread the paper?  
	




CHECK BOX 2
	HOUSE STYLE CHECKLIST for authors

	Is article title twelve words or fewer, AND a good indicator of the substance of the article? 
	

	Are authors’ names correct and in right order? 
	

	Are the Keywords the most suitable, and most likely to highlight your article? 
	

	Are JEL codes the most apt and suitable for your article?
	

	Is article language set for ENGLISH Australia or ENGLISH UK? 
	

	Is in-text spelling correct? (…isation, …ise (NOT ization / ize) except where it is an institutional name)?  
	

	Are in-text references correctly set out? (are you sure 😊? – see ELRR CambridgeA) 
	

	Are all acronyms and abbreviations in full the first time in the article? 
	

	Are subheadings clear and well placed (no numbers)?  
	

	Are diagrams, figures, graphs, and tables correctly numbered and titled?
	

	Is reference list correctly set out, including alphabetical order by first author? 
	

	Are all / most authors of any article, listed? (As per ELRR CambridgeA)
	

	Do all journal articles / book chapters have DOI (where possible)? 
	





